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1  Welcome to Livescribe Connect

Livescribe Connect makes it easy to send your notes and audio to people and destinations of your 
choice. All from your paper. 

Simply draw a line and write send. Tap the pages you want to send. Notes and audio are automatically 
sent as an interactive audio PDF file, called a Pencast. 

You can send Pencasts to destinations like Email, Facebook, Google™ Docs, Evernote®, and even 
your mobile device. You can also send to these destinations from within Livescribe Desktop. Simply 
drag and drop your pages to Connector icons to quickly send or share them. 
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Basic and Premium Connectors

Livescribe Connect supports two sets of Connectors—Connect Basic and Connect Premium. 

Livescribe Connect Basic is part of your free download of Livescribe Desktop.  Connect Basic includes 
the following Connectors:

• Computer 

• MyLivescribe 

• Evernote®

• Facebook 

You can purchase the Connect™ Premium Upgrade Pack from the Livescribe Application store. The 
Connect Premium pack includes:

• Email 

• Google™ Docs 

System Requirements

Livescribe Connect requires: 

• PC running Windows® XP SP3, Windows® Vista (32-bit), or Windows® 7 (32-bit or 64-bit). Or 
Mac running Mac OS 10.5.8 or higher. 

• Livescribe Desktop version 2.7 or higher. Install it from: http://www.livescribe.com/install

• Smartpen firmware version 2.7 or higher. This is installed to your docked smartpen when you run 
Livescribe Desktop version 2.7 or higher. 

• Adobe Air 2.6 or higher (installed automatically). 

• Adobe Reader 10.0.1 or higher to view Pencast PDF files. 
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2  Installing and Configuring

Livescribe Connect consists of two software apps: one for your computer and one for your smartpen. 

Install Livescribe Connect on your computer and your smartpen. Then in the computer app, configure 
Connectors and modify or create shortcuts for use on your smartpen. 

Before Installing the Livescribe Connect Apps

If you recently bought a Livescribe smartpen and installed Livescribe Desktop on your computer, you 
may already have Livescribe Connect on your computer and your smartpen. 

You should check if Livescribe Connect is installed on your computer and smartpen. 

Checking If Livescribe Connect Is Installed on Your Computer

Check for Livescribe Connect on your computer. You check differently on Windows and Mac. 

On Windows
• Choose Start > All Programs > Livescribe. If you see Livescribe Connect in the Livescribe 

folder, then the computer app is installed. 

On Mac
• Check for the Livescribe Connect icon in your Mac dock. If you see it, then the computer app is 

installed. 

If Livescribe Connect is not on your computer, proceed with installation now. 
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Checking If Livescribe Connect Is Installed on Your Smartpen

Check the main menu of your smartpen to see if Connect is installed. 

1. Double-tap on the center of the Nav Plus. 

2. Tap down until you see Connect. 
If you see it, the Livescribe Connect smartpen app is installed. 

If Livescribe Connect is not on your smartpen, proceed with installation now. 

Installing Livescribe Connect on Your Smartpen and Computer

You can install Livescribe Connect on your smartpen and computer by installing Livescribe Desktop or 
by updating your existing Livescribe Desktop. 

Livescribe Connect requires the following versions of desktop and smartpen software: 

•  Livescribe Desktop version 2.7 or higher on your computer. 

•  Smartpen firmware version 2.7 or higher on your Livescribe smartpen. 

If you do not have these versions, Livescribe Desktop prompts you to update them before installing 
Livescribe Connect. 

Installing Livescribe Connect and a New Livescribe Desktop

Installing Livescribe Desktop installs the Livescribe Connect computer and smartpen apps at the same 
time. 

If you have not yet installed Livescribe Desktop on your computer, install it now. Then check for updates 
that may be necessary. 

1. Disconnect your smartpen from your computer. 

2. Install Livescribe Desktop from http://www.livescribe.com/install. Follow instructions in the 
Livescribe Desktop installer. 
Livescribe Desktop and Livescribe Connect will be installed on your computer. 

3. Connect your smartpen to your computer. 
Your smartpen firmware will be updated and the Livescribe Connect smartpen app installed. 
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4. In Livescribe Desktop, select Help > Check For Updates.
Livescribe Desktop prompts you to update your Livescribe Desktop software and your smartpen 
firmware—if any of them need updates. 

5. Accept the updates. 
Updates will be installed automatically to your computer and smartpen. 

 To try out Livescribe Connect immediately, skip to Livescribe Connect Quick Start. Otherwise, proceed 
with configuring Connectors. 

Installing Livescribe Connect from an Existing Livescribe Desktop

Updating Livescribe Desktop installs the Livescribe Connect computer and smartpen software. 

From an existing Livescribe Desktop installation, select all updates. You will receive updates to 
Livescribe Desktop and the smartpen firmware. In addition, Livescribe Connect will be installed on your 
computer and smartpen. 

1. Connect your smartpen to your computer. 

2. In Livescribe Desktop, select Help > Check For Updates
You are prompted to update your Livescribe Desktop and your smartpen firmware, if they are out 
of date. 

3. Accept all updates. 
Updates will be installed to your computer and smartpen. 

 To try out Livescribe Connect immediately, skip to Livescribe Connect Quick Start. Otherwise, proceed 
with configuring Connectors. 

Configuring Connectors

Connectors are plugins to Livescribe Connect that target a particular destination, such as your 
computer, your Evernote notebooks, your MyLivescribe space, your Facebook wall, Email recipients, 
or your Google Docs collections. 

Configure your Connectors before using them. The Connectors tab of the Livescribe Connect 
computer app has an icon for each Connector. 
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If you are currently displaying Livescribe Desktop, you can access Livescribe Connect quickly by 
clicking an icon in the Connectors pane of Livescribe Desktop. The Livescribe Connect computer app 
will display with the Connectors tab open to the configuration page for the Connector you clicked. 

IMPORTANT:  In Livescribe Connect, click a Connector icon to display the configuration page. Then 
specify applicable login information and destination defaults (folder, collection, tags, post descriptions, 
etc.). 

NOTE:  In the Email Connector, you can also create an Address Book, which you use from the Livescribe 
Connect smartpen app. 

To configure particular Connectors, click one of the following links: 

• Configuring the Computer Connector

• Configuring the MyLivescribe Connector

• Configuring Mobile

• Configuring the Evernote Connector

• Configuring the Facebook Connector

• Configuring the Email Connector

• Configuring the Google Docs Connector

After configuring Connectors, you can use them to send notes and audio from the smartpen (with 
Livescribe Connect shortcuts) or from Livescribe Desktop. 

The Switch Connector Dropdown Menu

In the Livescribe Connect computer app, you can quickly move between Connectors during 
configuration. 

The Connectors tab has a Switch Connector dropdown menu in the right-hand corner. 

1. Click the Switch Connector control to display available Connectors. 

2. Select the name of a Connector. 
The configuration page of the Connector displays. 
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Modifying and Creating Shortcuts

Livescribe Connect shortcuts are how you use Connectors from the smartpen. A shortcut starts the 
Livescribe Connect smartpen application with appropriate parameters. 

A Livescribe Connect shortcut specifies destination values (folder, collection, tags, post descriptions, 
etc.) and sending formats. The destination values override any defaults specified in the configuration 
page of the Connector. Certain Connectors allow you to specify additional information. Each shortcut is 
associated with one Connector, though a Connector may have several shortcuts. 

Livescribe Connect comes with default shortcuts, which you may modify in certain ways. You can also 
create your own custom shortcuts. 

Shortcuts specify three kinds of information: 

• the Connector to use. 

• (optional) refinements of the destination settings of the Connector. These values override the 
default destination settings specified in the Connector configuration. 

NOTE:  Custom Email shortcuts allow you to enter email addresses to form a mail list. On the 
smartpen, your custom Email shortcut uses the mail list, and the smartpen app does not ask you 
for selections from the Address Book. 

• the format to send: PDF or PNG Image for notes only; M4A Audio for audio only; Pencast or 
Pencast PDF for notes and audio. Formats available depend on which Connector is selected. See 
Formats For Sending Notes and Audio. 

Modifying Shortcuts

Modify shortcuts on the Shortcuts tab of the Livescribe Connect computer app. 

For default shortcuts, you can modify: 

• the destination values, such as Folder for Computer; Notebook and Tags for Evernote; the post 
descriptions for Facebook; Collection and Share With for Google Docs. 

NOTE:  In the default Email shortcut, you cannot create a list of email recipients. You select email 
recipients from your Address Book while using the default Email shortcut on the smartpen. If you 
want to create a mail list, create a custom Email shortcut. 

• the Format in which the pages are sent. The formats available depend on which Connector is 
used. 

For custom shortcuts, you can change the Connector, as well. 
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Modify a shortcut, following these general steps. For details, click one of the links below. 

1. Click the row containing the shortcut you wish to modify. 

2. Click the down arrow in the Connector column and select a different Connector. 
NOTE:  You cannot change the Connectors of a default shortcut. 

3. Click the Add... links below the Connector. Specifying values here will override the destination 
defaults from the Connector configuration on the Connectors tab. 

4. Click the down-arrow in the Format column and select a send format. See Formats For Sending 
Notes and Audio. 

5. Click Save.
6. Connect (dock) your smartpen to your computer to transfer new and updated shortcuts to the 

smartpen.

For information on defining shortcuts for particular Connectors, click one of the links below: 

• Defining Shortcuts for Computer

• Defining Shortcuts for MyLivescribe

• Defining Shortcuts for Evernote

• Defining Shortcuts for Facebook

• Defining Shortcuts for Email

• Defining Shortcuts for Google Docs

Creating Custom Shortcuts

You can create custom shortcuts for Livescribe Connect. Custom shortcuts specify: 

• the Connector to use. 

• (optional) Refinements of the destination settings of the Connector. Settings you specify here 
override defaults specified in Connector configuration. 

• the format to send. 

Create a custom shortcut by following these general steps. For details, click one of the links below. 

1. Click Add Shortcut. 
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2. Enter a name for the shortcut. 
NOTE:  The shortcut name cannot be the same as any other Livescribe Connect shortcut or 
Connector name. You may enter all characters recognized by the locale currently selected on 
your smartpen. Spaces are allowed. Choose a shortcut name of just a few characters, since you 
will be writing it often. The shortcut name displays on the smartpen as you write it. 

3. Click the down-arrow in the Connector column and select a Connector. 
Additional links may appear, depending on the Connector selected. 

4. Click the Add... links below the Connector, if desired. Specifying values here overrides the 
destination defaults from the Connector configure page. 
NOTE:  When creating a custom Email shortcut, you can enter email addresses to form a mail list. 
Click the To, CC, and BCC links to enter email addresses in those fields. On the smartpen, your 
custom Email shortcut uses the mail list; the smartpen app does not ask you for selections from 
the Address Book. 

5. Click the down-arrow in the Format column. 
The menu contains available formats for the Connector. See Formats For Sending Notes and 
Audio. 

6. Select the desired format. 

7. Click Save.
8. Connect (dock) your smartpen to your computer to transfer new and updated shortcuts to the 

smartpen.

For information on defining shortcuts for particular Connectors, click one of the links below: 

• Creating a Custom Shortcut for Computer

• Creating a Custom Shortcut for MyLivescribe

• Creating a Custom Shortcut for Evernote

• Creating a Custom Shortcut for Facebook

• Creating a Custom Shortcut for Email

• Creating a Custom Shortcut for Google Docs

The Me Shortcut

The Me shortcut gives you a quick alternative to creating a custom shortcut. You can modify all aspects 
of the Me shortcut, except the shortcut name. 
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You can select: 

• the Connector to use. 

• the destination settings. Click a link below the Connector name to enter values for the settings. 

• the Format in which to send your notes and audio. See Formats For Sending Notes and Audio. 

You can modify the definition of the Me shortcut as often as you like. Dock your smartpen to your 
computer to transfer the new Me definition to your smartpen. 

Deleting a Custom Shortcut

You can delete a custom shortcut on the Shortcuts tab of the Livescribe Connect computer app. You 
cannot delete default shortcuts. 

1. Click in a shortcut row on the Shortcuts tab. 

2. Click the Delete This Shortcut button. 

Starting and Stopping Livescribe Connect

You can start and exit the Livescribe Connect computer app and configure it to automatically transfer 
data at smartpen dock. These tasks differ on Windows and Mac. 

Starting and Stopping Livescribe Connect (Windows)

You can manually start and exit Livescribe Connect, check if it is currently running, and display the app's 
window. You can also control whether Livescribe Connect transfers data automatically when you dock 
your smartpen to the computer. 

Manually Starting Livescribe Connect (Windows)
• Choose Start > All Programs > Livescribe > Livescribe Connect. 

NOTE:  You can also set Livescribe Connect so that it starts automatically when you connect the 
smartpen to the computer. See Automatically Starting Data Transfer at Smartpen Dock (Windows)

Checking If Livescribe Connect Is Running (Windows)

You can check if Livescribe Connect is currently running. 
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NOTE:  Clicking either the minimize button or the close button on the Livescribe Connect window closes 
the window, but leaves the app running. 

• Check the Windows system tray. 
If the app is running, you will see the Livescribe Connect icon: 

Displaying the Livescribe Connect Window

The Livescribe Connect window may be closed because you clicked the minimize button or the close 
button. However, the app is still running. You can re-display the window from the Start menu or the 
Windows system tray. 

Displaying the Window from the Start Menu
• Choose Start > All Programs > Livescribe > Livescribe Connect. 

If the app is running, the window displays. If the app is not running, it starts and the window 
displays. 

Displaying the Window from the System Tray

When the Livescribe Connect is running, you can display the Livescribe Connect window from the 
Windows system tray. 

• Click the Livescribe Connect icon in the Windows system tray. 
Alternatively, you can right-click the Livescribe Connect icon in the Windows system tray and 
choose Open Livescribe Connect. 

Exiting Livescribe Connect Computer App (Windows)

You can exit Livescribe Connect from the Windows system tray. 

This is the primary way to exit Livescribe Connect. Closing the Livescribe Connect window does not exit 
the app. 

1. Right-click the Livescribe Connect icon in your system tray. 
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2. Select Exit on the popup menu. 
The Livescribe Connect computer app exits. The icon no longer appears in the system tray or the 
Hidden Icons Menu. 

Automatically Starting Data Transfer at Smartpen Dock (Windows)

Livescribe Connect can automatically transfer data with the smartpen whenever you connect (dock) the 
smartpen to the computer. You access the appropriate setting in Livescribe Desktop. 

1. Start Livescribe Desktop. 

2. Click Tools -> Livescribe Desktop Settings. 
The User Settings dialog displays. 

3. Under Settings -> Livescribe Desktop, click General. 
The General settings pane displays. 

4. Select the Autolaunch Livescribe Connect when the smartpen is connected check box. 

Preventing Data Transfers at Smartpen Dock

IMPORTANT:  If you do not want data transfers to start when you connect your smartpen to the computer, 
you must do the following: 

1. Deselect the check box, as described above. 

2. Exit Livescribe Connect. See Exiting Livescribe Connect Computer App (Windows)

3. Connect your smartpen to the computer. 

System Tray on Different Versions of Windows

The Windows system tray displays differently on different versions of Windows. 

Check Box Description

Selected Livescribe Connect will begin transferring data with the smartpen when you 
connect the smartpen to your computer. If not already running, Livescribe 
Connect will be automatically started.

Deselected When you connect your smartpen to the computer and Livescribe Connect is 
not running, no data transfers occur. You must manually start Livescribe 
Connect for data transfer to begin.
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Windows XP and Windows Vista

The Livescribe Connect icon displays in the system tray when the app is running: 

Some of the system tray icons may be hidden. In that case, you will see a left arrow at the end of the 
task bar: 

Click it to display the full system tray. 

Windows 7

In Windows 7: the Livescribe Connect icon may display in the Hidden Icons window instead of in the 
system tray. If you do not see the Livescribe Connect icon in the system tray, click the up arrow to 
display the Hidden Icons menu. 

In the Hidden Icons menu, click the Livescribe Connect icon to display the main window of the app. 
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If you wish to ensure that the Livescribe Connect icon always appears in the system tray, click 
Customize, find Connect Tray in the list, and make sure Show icon and notifications is selected. 

Starting and Stopping Livescribe Connect (Mac)

You can start and quit Livescribe Connect and open the Livescribe Connect window. 

Manually Starting Livescribe Connect On Your Mac

You can start Livescribe Connect in the normal manner. 

• Click the Livescribe Connect icon in the Dock. 

Checking If Livescribe Connect Is Running (Mac)

You can check if Livescribe Connect is currently running. 

NOTE:  Clicking either the yellow Minimize or the red Close button on the Livescribe Connect window 
closes the window, but leaves the app running. 

• Right-click the Livescribe Connect icon in the Dock. 
The popup menu displays the next action you can take. 

Opening the Livescribe Connect Window

The Livescribe Connect window may be closed because you clicked the Yellow minimize button or the 
Red close button. However, the app is still running. You can open the window from the Dock. 

• Click the Livescribe Connect icon in the Dock. 

Quitting Livescribe Connect (Mac)

You can quit Livescribe Connect from the Dock, using the popup menu. 

Menu Item Current Status

Quit Livescribe Connect is running. You can stop it by choosing Quit.

Open Livescribe Connect is not running. You can start it by choosing Open.
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This is the primary way to quit Livescribe Connect. Closing the Livescribe Connect window does not quit 
the app. 

• Right-click the Livescribe Connect icon on the Dock, and choose Quit. 

Livescribe Connect Status Icons

The Livescribe Connect icons indicate the app’s current status. They appear in the corner of the 
Livescribe Connect window. 

If you see the error icon, exit the Livescribe Connect computer app, and start it again. 

Icon Description 

Livescribe Connect is running normally. 

Livescribe Connect is transferring data with the Livescribe smartpen. 

Livescribe Connect has experienced an error. 
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3  Livescribe Connect Quick Start

The Quick Start guides you through using your first Connector—the Computer Connector. Then it 
provides an overview called Connectors at a Glance. 

Using Your First Livescribe Connect Shortcut

Use a Livescribe Connect shortcut on your smartpen to access a Connector. For instance, you can 
access the Computer Connector by using its shortcut Computer. 

1. Capture notes and audio on a notebook page. 

2. Draw Launch Line: Write a horizontal line and—without lifting your smartpen—retrace your line in 
the opposite direction. A Launch Line is a line drawn there and back again, about the length of 
the display on your smartpen.
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3. Within 8 seconds, write the word Computer directly above the line. For more information see 
Drawing a Launch Line. 

4. When the smartpen display prompts you to select pages, tap on a notebook page that you want 
to send to your computer. Tap on each additional page to select it. When you reach the final page 
you want to send, double-tap on it. 

5. Connect (dock) your smartpen to your computer. Livescribe Connect transfers the notes and 
audio to your computer. 

6. When the transfer finishes, look on your computer’s desktop for a Pencast PDF of the pages you 
selected. 
This example assumes the default settings for Livescribe Connect and the Computer Connector. 
For example, it uses the default folder location for the Computer Connector and the default 
Pencast PDF format. If you changed the folder location, look for your uploaded files in the new 
folder. 

7. Open the Pencast PDF using Acrobat Reader, and play the audio in the file by clicking on the 
green ink or using the audio control bar. 

Congratulations! You just created your first Pencast PDF using Livescribe Connect! 
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Connectors at a Glance

This is a brief overview of Livescribe Connect for those who are very experienced with computer 
software and want to get started quickly. 

Read this section first, followed by Comparing Connectors. If you get stuck at any step or if you simply 
prefer fuller descriptions and instructions, click a link below. 

Start Here

Livescribe Connect consists of a computer app and a smartpen app. Start by launching the Livescribe 
Connector computer app. You will use the Connectors tab and the Shortcuts tab. 

NOTE:  If you are currently displaying Livescribe Desktop, you can access Livescribe Connect on your 
computer by clicking an icon in the Connectors pane of Livescribe Desktop. The Livescribe Connect 
computer app will display with the Connectors tab open to the configuration page for the Connector 
you clicked. 

Connectors Tab

Each type of destination is handled by a plugin called a Connector. You must configure Connectors 
before using them, including: 

• Account settings (username and password, outgoing email server settings) 

• Default destination settings (folders, collections, post descriptors, address book, etc.) 

See Configuring Connectors. 

Sending Notes and Audio with a Connector

Sending notes and audio with a Connector requires you to use one of the following: 

• a Livescribe Connect shortcut (on the smartpen). 

OR 

• the Connectors pane in Livescribe Desktop. 

See Sending Notes and Audio with Your Smartpen and Sending Notes and Audio from Livescribe Desktop.
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Shortcuts Tab

A Livescribe Connect shortcut is a word that you write with your smartpen to use a Connector. When 
you dock your smartpen to your computer, Livescribe Connect sends selected notebook pages and 
audio to the Connector's destination. 

Each row in the Shortcuts table defines one shortcut, which includes values for the following: 

• the Connector to use. (Connectors must first be configured on the Connectors tab.) 

• (optional) refinements of the default destination settings of the Connector. These are usually 
overrides of default settings. 

• the format in which to send the notes and audio: 

PDF or PNG Image for pages only; M4A Audio for audio only; .pencast or Pencast PDF for 
pages and audio. Formats available depend on which Connector is selected. 

NOTE:  When using the default Email shortcut, you must also select email recipients from the Address 
Book you created during Email Connector configuration. 

Default and Custom Shortcuts

Livescribe Connect comes with several default shortcuts. To create custom shortcuts: 

1. Click on Add Shortcut.
Your shortcut name must be unique. It cannot be used by other Livescribe Connect shortcuts on 
your smartpen. 

2. Select the Connector you wish to use. 

3. (optional) Enter values for the destination settings below the Connector. These values will 
override any that are set in the configuration page of the Connectors tab. 

4. (optional) Select the Format. 
5. Connect (dock) your smartpen to your computer to transfer new and updated shortcuts to the 

smartpen.

Default shortcuts include the name of each Connector: Computer, MyLivescribe, Evernote, Facebook, 
Email, and Google Docs. 

See Modifying Shortcuts and Creating Custom Shortcuts. 



Connectors at a Glance

Chapter 3:  Livescribe Connect Quick Start 27

Using a Livescribe Connect Shortcut on Your Smartpen

1. Draw a Launch Line: Write a horizontal line and—without lifting your smartpen—retrace your line 
in the opposite direction. Then write the shortcut name directly above the line. 

For more information on Launch Line, see Drawing a Launch Line. 

2. Tap on one or more pages in your notebook. Double-tap on the final page. 

3. Follow instructions on your smartpen display. 

4. Dock the smartpen to your computer. 

See the following for step-by-step instructions on configuring Connectors, modifying and creating 
shortcuts, and using shortcuts to send notes and audio from your smartpen. 

• Sending to Computer

• Sending to MyLivescribe

• Sending to Mobile

• Sending to Evernote

• Sending to Facebook
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• Sending to Email Recipients

• Sending to Google Docs

The Email Connector and File Size

When using the Email Connector, keep in mind that some files, particularly those with audio, are too 
large for many people's email systems. For information and alternatives, see Sending Large Files with 
Livescribe Connect. 

Sending Entire Recordings

When you select a page or a part of page to send, any audio recording associated with the notes will 
be sent in its entirety. For details, see Sending Entire Audio Recording(s) with Note Selection. 

Comparing Connectors

While the general pattern for Connector use is the same, each Connector requires specific information 
to accomplish its job. 

You specify most of this information during configuration of a Connector. Other information you specify 
in the shortcut definition or from the Livescribe Connect smartpen app. If the same information type is 
specified in multiple places, priority goes like this: Shortcut definition overrides Connector configuration, 
and smartpen overrides them all. 

Connector Info Specific to the Connector 

Computer Folder Folder on your computer where notes and audio will be sent. 

MyLivescribe Email Email address for logging in to MyLivescribe in Livescribe Online. 
Livescribe Connect automatically logs you in when you send notes and 
audio to MyLivescribe. 

Password Password for logging into MyLivescribe in Livescribe Online. 
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Default 
Pencast 
Name 

Name that will display beneath your Pencast when it is uploaded to 
MyLivescribe. 

Mobile same as MyLivescribe

Evernote® User name User name for logging in to your Evernote account. Livescribe Connect 
automatically logs you in when you send notes and audio to Evernote. 

Password Password for logging in to your Evernote account. 

Notebook Evernote notebook to which notes and audio will be sent. If you specify no 
notebook, they will be sent to the default notebook you specified in 
Evernote online. 

Tags Evernote tag(s) that will be attached to notes and audio when they are 
sent. If the tags do not exist in your Evernote account, they will be created 
automatically. 

Facebook Sign in to 
Facebook 

Button you push to display the Facebook Login dialog, where you enter 
email account and password for logging in to your Facebook account. 
To send notes and audio to your Facebook account, you must be currently 
logged in: Click Sign in to Facebook. Click Keep me logged in, if you do 
not want to manually log in to Facebook each time you send content. Click 
Login.
If the button says Sign out of Facebook, you are currently logged in to 
Facebook and can send notes and audio. Clicking Sign out of Facebook, 
logs you out of your Facebook account. 

Wall 
Message 

Your message. Will appear beneath your name and above the Pencast in 
your post. 

Wall Name Title, in bold type, of the Pencast. Will appear to the right of the Pencast in 
your post. 

Caption Quick summary of the Pencast. Will appear beneath the Wall Name in 
your post. 

Description One or two sentence description of the Pencast. Will appear beneath the 
Caption in your post. 

Connector Info Specific to the Connector 
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Email Outgoing 
Message 
Info 

Information that you enter during Email Connector configuration. It 
appears in the email that you send. Your Name and Your Email Address 
apply to the From field of your email. Default Subject and Always BBC 
emails to are defaults that you can override in the Subject and BCC fields 
of a custom Email shortcut. Signature provides the closing, usually your 
name, at the bottom of your email.

Email Setup 
Info 

Information that you enter during Email Connector configuration. It allows 
Livescribe Connect to log in to your mail server and send your email. Most 
server types in Email Service require your email address and password 
only. 
If your Email Service is Microsoft Exchange, you must provide: 

User Name 
Your user name only. No domain (such as @xyzcompany.com) 
required. 

Password 
Your password for logging in to the mail server. 

Outgoing mail server (SMTP) 
Mail server name and domain. Ask your administrator. An example 
is: mail.xyzcompany.com

Port 
Ask your administrator. Default is often 587

Use a secure connection SSL 
Ask your administrator. Answer is often yes; select the check box. 

Address 
Book 

Email addresses you enter during Email Connector configuration. When 
you use the default Email Connector, the smartpen will ask you to select 
addresses from this book. The Address Book is not used by custom Email 
shortcuts. 

To, CC, 
BCC 

When defining custom Email shortcuts: enter email recipients in these 
fields. Each custom Email shortcut becomes a kind of mailing list. You 
cannot override these fields from the smartpen. 
When you are using the default Email shortcut, the smartpen asks you to 
select email reciepients from the Address Book instead. 

Connector Info Specific to the Connector 
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Subject When defining custom Email shortcuts: enter a subject. It overrides the 
Default Subject in the Email Connector configuration. 
You cannot override this field from the smartpen.

Google™ Docs Collection Name of the Collection (folder) to which your notes and audio should be 
sent in your Google Docs account. If you specify a Collection that does not 
exist in your Google Docs account, it is created automatically. 

Share With Email addresses of people with whom you want to share. They will have 
access to these notes and audio on Google Docs. 

Connector Info Specific to the Connector 
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4  Launching the Livescribe Connect 
Smartpen App

You can launch the Livescribe Connect smartpen app by using shortcuts or the Nav Plus. 

Launch Line and a Shortcut

There are two kinds of shortcuts you can use with the Livescribe Connect smartpen app: 

• A general launch shortcut, such as Send or Connect, starts the smartpen app and displays a 
menu within the app. You tap right or down to navigate the smartpen app menus, where you can 
select a Connector shortcut, send an entire notebook, access application information, or other 
tasks. 

• A Connector shortcut launches the smartpen app and automatically selects the appropriate 
Connector with settings defined in the shortcut. The smartpen then instructs you to start selecting 
pages in a Livescribe notebook. 

Nav Plus

You can also start the smartpen app by using Nav Plus to navigate the smartpen app menus, where 
you can select a Connector shortcut, send an entire notebook, access application information, or other 
tasks. 

Launching Connect with Launch Line and Shortcuts

You can launch the Livescribe Connect smartpen app using Launch Line and a shortcut. You can then 
use Tap Around to access submenus of the app.

The Livescribe Connect smartpen app responds to a variety of shortcuts: 

• the Connect shortcut. 
• the Send shortcut. 
• the default Livescribe Connect shortcuts. 
• the custom Livescribe Connect shortcuts. 
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Drawing a Launch Line

You can launch Connect on your smartpen by drawing a Launch Line and writing a Connect shortcut.

1. Write a horizontal line, but don't lift your smartpen tip from the paper yet. 

2. Retrace your line in the opposite direction. 
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3. Within 8 seconds, write the shortcut word—such as Computer. 

Using its predictive text feature, your smartpen displays the first shortcut that matches your 
written input. As soon as you see the shortcut you want, you can stop writing.
The Connect smartpen app will launch and the appropriate menu will show on the smartpen 
display. 

4. Look at the smartpen display to determine the current menu. 
If you wrote Send, you will see the Share via menu. If you wrote Connect, you will see the Send 
menu. If you wrote a Connector shortcut, such as Computer, you will see a message asking you 
to tap a notebook page to select it. 

Navigating Submenus with Tap Around

You can access submenus in a smartpen app, including Livescribe Connect. For instance, the default 
Email Connector asks you to select email recipients from the Address Book. Or you might wish to 
change the sending format of your notes and audio right from the smartpen. In addition, you can access 
Connect menu items such as Send Entire Notebook or About. 

Tapping left, right, up, or down changes the menu item in the smartpen display. There are two ways to 
navigate submenus: 
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• Tapping on the directional arrows of a Nav Plus. See Launching Livescribe Connect from the Nav 
Plus. 

• Using Launch Line Tap Around. 

Tap Around

After you write a Launch Line and shortcut word, you can tap up, down , left, or right around the Launch 
Line word to access menus of the Connect smartpen app. The active areas for up, down, left, and right 
are invisible rectangles extending 1/4" outward from the shortcut word in the four directions. In the 
illustration, the shortcut word is Settings, which launches the smartpen's Settings app. With 
Livescribe Connect, your shortcut word will be Send, Connect, Email, Computer, MyLivescribe, 
etc. 

NOTE:  You can use Tap Around with a Launch Line and shortcut word that you wrote in the past. Just 
tap on the word to activate the app, and then tap up, down, right, or left. 
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The following illustration shows a smartpen tapping right on a previously written Send shortcut. 

The next illustration shows a smartpen tapping down. 
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Launching Livescribe Connect with the Connect Shortcut

You can launch Livescribe Connect on the smartpen by drawing a special line and then writing the word 
Connect. 

1. Draw a Launch Line: Write a horizontal line and—without lifting your smartpen—retrace your line 
in the opposite direction. 

2. Write the first few letters of the Connect shortcut directly above the Launch Line. 

For example, writing Con displays the Connect shortcut. 
Using its predictive text feature, your smartpen displays the first shortcut that matches your 
written input. As soon as you see the shortcut you want, you can stop writing. 

3. Wait until the smartpen displays shows: Send. 
The Livescribe Connect smartpen app has started and is displaying the Send menu. 

4. Tap right to display the Share via menu, which lists all Livescribe Connect shortcuts. Or tap down 
to access other app options. 
Once you have written a Launch Line, you can tap where you wrote it to repeat the action. You 
can re-launch the Livescribe Connect app at any time by tapping your Connect shortcut. 

The Connect shortcut is best for accessing items on the app's root menu, such as Send Entire 
Notebook or About. If you just want to select a Connector, use the Send shortcut. 
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Launching Livescribe Connect with the Send Shortcut

The Send shortcut is best when you want to select a Connector from the list. 

Follow the same steps as for the Connect shortcut, but write Send instead of Connect. The Livescribe 
Connect smartpen app launches, and the Share via menu displays on the smartpen. 

Launching Livescribe Connect with Default Shortcuts

You can launch Livescribe Connect on the smartpen by drawing a Launch Line and then writing the 
name of the default shortcut you want to use. 

Livescribe Connect shortcuts launch the smartpen app, select the appropriate shortcut, and instruct you 
to start selecting pages by tapping on them. Each Connector has a default shortcut that is the same as 
the Connector name. Livescribe Connect comes with other default shortcuts as well. Default shortcuts 
include: Computer, MyLivescribe, Mobile, Evernote, Facebook, Email and Google Docs. 

1. Draw a Launch Line and write the first few letters of the shortcut you want to use. For example, 
writing Com shows Computer on the smartpen display. 
Using its predictive text feature, your smartpen displays the first shortcut that matches your 
written input. As soon as you see the shortcut you want, you can stop writing. 

2. Wait until the smartpen displays shows: Tap each page to include, then double tap. 
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3. Tap on a notebook page. Tap on each additional page. Then double-tap on the last page you wish 
to send. 
The next time you dock your smartpen to your computer, the notebook pages are sent in the 
format specified by the shortcut. 
Once you have written a shortcut with Launch Line, you can tap where you wrote it to repeat the 
action. You can re-launch the app at any time by tapping your Launch Line shortcut word. 

Launching Livescribe Connect with Custom Shortcuts

You can launch the Livescribe Connect smartpen app, using custom shortcuts that you create. 

Launch Livescribe Connect smartpen app by using custom shortcuts in the same way you use default 
shortcuts. 

Launching Livescribe Connect from the Nav Plus

You can launch Connect with the Nav Plus printed in the corner of Livescribe notebooks and notepads. 
You can also navigate the submenus of the Connect smartpen app by tapping on the up, down, right, 
and left directional arrows of the Nav Plus. 

1. Double-tap on the center of a Nav Plus to go to the Main Menu. 

2. Tap down until you locate the Connect app. 

3. Tap right to launch Connect. 

NOTE:  Nav Plus is an alternative to drawing a Launch Line and using Tap Around. 
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5  Selecting Notes And Audio with the 
Smartpen

You can select notes and audio you want to send by tapping on pages in a Livescribe notebook. You 
can send whole pages or portions of pages. You can send an entire notebook to your computer and 
keep the sent file synchronized with new notes and audio you add to the notebook. 

Selecting Pages on the Livescribe Smartpen

You can select notes and associated audio by tapping on pages in your notebook. 

1. Launch the Connect app on the smartpen with the Send shortcut. 

2. When the smartpen displays Share via, tap down to find a Connector, and then tap right. 

3. Tap on one or more pages in your notebook to select them for sending. 

4. Double-tap on the final page you want to send. 
The default Email shortcut has an additional step: it asks you to select email recipients from the 
Address Book. 

5. Connect (dock) your smartpen to your computer to send the notes and audio. 

NOTE:  All pages you select must be in the same notebook. If you want to send content from multiple 
notebooks, send pages from the first notebook, and then send pages from the next notebook. 

Selecting Part of a Notebook Page

You can send parts of a notebook page, if you prefer not to send the whole page. 

To send part of a notebook page: 

1. Launch the Livescribe Connect smartpen app, using the Send shortcut. 
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2. When the smartpen displays Share via, tap down until you see the Connector you want to use. 
Tap right. 
The smartpen display shows: Tap each page to include, then double-tap.

3. Instead of tapping on a page, draw a box around the area of the page you wish to send. 
Draw the entire box without lifting your smartpen from the page. 

The smartpen display shows: 1 Area selected.
4. Draw another box to select a different part of that page or another page. 

The smartpen display shows: 2 Areas selected.
5. Continue drawing boxes to select parts of pages. 

6. When you are done selecting areas, double-tap. 
If you are using the default Email Connector, select email addresses from the Address Book. 

Each page you touched is sent, but only the parts you selected are visible. 

When making selections, you can mix entire pages with portions of a page. For instance, you can select 
all of page 10, draw a box to select a portion of page 13, and select two boxes on page 21. All selections, 
however, must be in the same notebook. 

NOTE:  When sending a page or a part of a page, any audio recording associated with your selection will 
be sent in its entirety. For details, see Sending Entire Audio Recording(s) with Note Selection. 
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IMPORTANT:  You cannot select part of a page when using the MyLivescribe Connector. You can select 
only a whole page. Livescribe Connect shortcuts that use the MyLivescribe Connector include: 
MyLivescribe, Mobile, iPad, and iPhone. 

Selecting Part of a Page with Vertical Lines

As an alternative to selecting part of a page by drawing a box, you can draw a vertical line to the left of 
the notes to be sent. 

NOTE:  When sending a page or a part of a page, any audio recording associated with your selection will 
be sent in its entirety. For details, see Sending Entire Audio Recording(s) with Note Selection. 

IMPORTANT:  You cannot select part of a page when using the MyLivescribe Connector. You can select 
only a whole page. Livescribe Connect shortcuts that use the MyLivescribe Connector include: 
MyLivescribe, Mobile, iPad, and iPhone. 

Selecting Audio to Send

On the smartpen, you send audio from a notebook page by selecting the format of the files sent. 

If you specify the following formats, audio is sent: 

• Pencast (notes and audio) 
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• Pencast PDF (notes and audio) 

• M4A Audio (audio only) 

Shortcuts specify the default send format in the Shortcuts tab of the Livescribe Connect computer app. 
You can override the default format when selecting pages on the smartpen. 

Sending Entire Audio Recording(s) with Note Selection

When you select notes, any recording associated with the notes is sent in its entirety. 

IMPORTANT:  Even if you select a single page or part of page, each recording associated with any of the 
selected notes is sent without being clipped. Consequently, a few brief notes that you send as Pencast 
PDF may include a long audio recording or even multiple recordings. 

Stop and Start Recording at Key Points

An audio recording is bounded by your tapping the Record button and later the Stop button. For 
instance, consider a lengthy meeting. If you stop and re-start recording on your smartpen, you will end 
up with two separate recordings. 

TIP:  One strategy to break a longer meeting, class, or interview into separate chunks is to stop the 
recording and then start a new one at key points, notating the fact in your notebook. Be careful to enter 
your notes in order and not go back to earlier notes while audio recording is on. If you observe that rule, 
each section of your notes will contain only one recording. However, if you go back to an earlier section 
while recording (or while listening to a recording after the meeting), that section will contain both the old 
and newer recordings. 

Preview Recordings in Livescribe Desktop

You can preview your audio recordings in Livescribe Desktop. Connect (dock) your smartpen to your 
computer. Then try sending from Livescribe Desktop. In the More Options section of the Sending 
Notes... dialog, you can play a recording and use the timeline controls to verify what you are about to 
send. 
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Sending an Entire Notebook from Your Smartpen

You can send an entire notebook to your computer from your smartpen. 

Livescribe Connect sends the notebook as a Pencast PDF file, using the Computer Connector. As with 
all Pencast PDFs sent to your computer, the Pencast PDF file will be updated each time you dock your 
smartpen. Such updating is similar to the way that Livescribe Desktop updates your electronic 
notebooks when you dock your smartpen. 

1. Launch the Livescribe Connect smartpen app using the Connect shortcut or a Nav Plus. 

2. On the Send menu, tap down until you see Send Entire Notebook. See Navigating Submenus 
with Tap Around. 

3. Tap right. 
Share Notebook via shows on the smartpen display. 

4. Tap down until you see the Livescribe Connect shortcut you want. Choices are: 
• Computer 
• Me 
• PDF 

NOTE:  The Me shortcut must use the Computer Connector. You cannot send an entire notebook 
from the smartpen using other Connectors. 

5. Tap on any page in the notebook you want to send. 

6. Connect (dock) your smartpen to your computer. 
Livescribe Connect sends your entire notebook as a Pencast PDF to your computer. Every time 
you dock your smartpen, the notebook’s new content is sent to the same file in the folder. The file 
on your computer contains notes and audio from the paper notebook, as of the last time you 
docked your smartpen. 

For automatic updating to occur, the Pencast PDF file on your computer must remain unchanged. 
Renaming, moving, or in any way modifying the file on your computer breaks the updating link. 

TIP:  If you decide that you do not want the Pencast PDF file to update, rename it. 

Pencast PDF Files and Notebook Archiving

If you send a notebook using the Send Entire Notebook feature and later archive the notebook in 
Livescribe Desktop, rename the Pencast PDF in your computer folder. Otherwise, you may lose 
information. If you start writing in a new notebook of the same type, Livescribe Connect will overwrite 
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the old Pencast PDF file with notes and audio from the new notebook—unless you change the name of 
the old file. 

Selecting Format from the Smartpen

When selecting notes and audio with your smartpen, you can also select the format in which they are 
sent. 

Generally, you accept the format specified in a shortcut. If you want a different format, you can modify 
an existing shortcut or create a new one. It can be convenient, however, to select the Format on the 
smartpen when you select pages from a notebook. For instance, you may decide at the last minute to 
send notes only or audio only, regardless of the format setting in the shortcut. 

The format you select on the smartpen overrides the format specified in the shortcut. 

Not all Connectors have a format that can be overridden. You are able to select aformat from the 
smartpen for the following Connectors: 

• Computer 

• Evernote 

• Email Connector 

• Google Docs 

NOTE:  You can access the optional Format submenu after selecting a pages (or portions of a page) and 
before double-tapping to end selection. 

1. After you have tapped the final page you wish to send and the smartpen is displaying the number 
of pages you selected (such as “1 page selected” or “2 pages selected”), tap right. 
The smartpen display shows Send As and then the default format specified by the shortcut you 
are using. 

2. Tap down to display the next available send format. Continue tapping down until you see the send 
format you wish. See Navigating Submenus with Tap Around. 

3. Tap right to select it. 

4. Double tap to finish using the current shortcut (or to proceed with selecting email addresses, if 
you are using the default Email shortcut. 
Next time you dock your smartpen to your computer, the notes and audio you selected are sent 
in the format you selected. 
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6  Sending Notes and Audio with Your 
Smartpen

You can write notes and audio in Livescribe notebooks and notepads and send them by connecting 
(docking) with your computer. 

This section discusses several general issues. Then it provides a mini-tutorial for using each Connector 
with the smartpen, walking you step-by-step through: 

• configuring the Connector. 

• creating Livescribe Connect shortcuts. 

• sending notes and audio with a shortcut. 

Detailed configuration information is provide for each Connector. 

You Can Send with the Smartpen or from Livescribe Desktop

You can send notes and audio by using your smartpen and Livescribe paper notebooks. You can also 
send notes and audio from Livescribe Desktop. 

Sending vs. Sharing

Sending notes and audio is not necessarily the same as Sharing them. 

If you are sending to a destination that lets you share with others, then sending may result in sharing if 
you configure it to do so. 

• With some Connectors, you can indicate a share setting when you configure the Connector. An 
example is sending to Google Docs. You specify with whom you wish to share your sent notes 
and audio when you create shortcuts for the Google Docs Connector or when you send from 
Livescribe Desktop. 

• With other Connectors, sharing is pre-set on the destination side. The Pencasts you post to 
Facebook have the privacy settings you choose in Facebook for posts to your wall. The notes and 
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audio you send to Evernote have the privacy setting you choose in Evernote for the destination 
notebook. The notes and audio you send to Computer have the access rights of the destination 
folder on your computer. 

• With still other Connectors, the notes and audio have a private setting. You can decide to share 
them later at the destination side. For example, sending to MyLivescribe results in a Pencast with 
a private setting. 

• Finally, with some Connectors, the sharing is implicit. When you send email to individuals, you 
are sharing it at the same time. 

Sending Large Files with Livescribe Connect

When you send notebook pages that contain lengthy audio, the resulting file can be quite large. Not all 
Connectors are appropriate for sending large files. 

Forty minutes of recorded audio creates a file about 10 MB in size. 

In general, the Computer and Google Docs Connectors are the best choice for large files. Some 
destinations, such as Facebook, have a maximum recommended upload size. 

NOTE:  The Email Connector is best for files of small to medium size, since many mail servers limit 
attachments to a maximum size of 10 MB. Keep in mind that although your mail server may have a 
larger limit, you cannot be sure what limits apply to the mail servers that deliver email to your recipients. 

Sending Entire Audio Recordings

When you select notes, any recording associated with the notes is sent in its entirety. 

For example, when selecting a page or a part of page to send, any audio recording associated with the 
notes will be sent in its entirety. For details, see Sending Entire Audio Recording(s) with Note Selection. 

Canceling Send Operations from the Smartpen

You can cancel send operations by selecting the Reset menu item before docking your smartpen. 

1. Launch the Livescribe Connect smartpen app, using the Connect shortcut or Nav Plus. 

2. Tap down until you see About on the smartpen display. 
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3. Tap right. 
The current version of the Livescribe Connect smartpen app shows on the display. 

4. Tap down until you see Help. 

5. Tap right. 
The address for the Livescribe support web page shows on the display. 

6. Tap down until you see Reset. 
7. Tap right. 

8. Tap right again to confirm. 
All send operations you have queued up on the smartpen since your last dock will be canceled. 
Notes and audio you selected will not be sent. 

Sending From Your Smartpen: Mini-Tutorials for Each Connector

Livescribe Connect has plugins—called Connectors—each of which targets a different destination for 
sending your notes and, optionally, audio. 

In the Livescribe Connect computer app, you can configure Connectors, modify a Connector’s default 
shortcut, and create custom shortcuts for a Connector. On the Livescribe smartpen, you launch the 
Livescribe Connect smartpen app with a shortcut and then provide other input the Connector needs to 
complete its job. 

The following sections contain mini-tutorials on configuring a Connector, creating a shortcut for it, and 
using the shortcut on the smartpen. Each Connector section is self-contained and provides the 
information you need to complete it. Click one of the links below. 

• Sending to Computer

• Sending to MyLivescribe

• Sending to Mobile

• Sending to Evernote

• Sending to Facebook

• Sending to Email Recipients

• Sending to Google Docs
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Sending to Computer

Using the Computer Connector, you can send notes and audio to a folder on your computer. The 
following mini-tutorials configure the Computer Connector, create a custom shortcut, and send content 
from your smartpen using the new shortcut. 

Configuring the Computer Connector

In this mini-tutorial, you configure the Computer Connector. 

1. Click the Computer icon on the Connectors tab of the Livescribe Connect computer app. 
The path shown under Default Folder Location is the default location to which your notes and 
audio are sent. You can override this default value by creating custom shortcuts for the Computer 
Connector. 

2. If you wish a different default location, click Choose a different folder and specify a path on your 
computer. 
The initial value for the Default Folder Location is your computer’s Desktop folder. 

3. Pencast PDFs sent to your computer using the Computer Connector are updated automatically 
with new ink and audio that you add to your paper product. 
This automatic updating occurs every time you dock your smartpen. It is similar to how Livescribe 
Desktop updates your notebooks when you dock your smartpen. 

Defining Shortcuts for Computer

The Computer Connector has default shortcuts that you can modify. You can also create your own 
custom shortcuts. 

The Computer Connector has the following default shortcuts: 

• Computer 

• PDF 

Default and custom Computer shortcuts specify the following: 

• the Computer Connector. This cannot be changed in default shortcuts. 

• the Folder on your computer to which the notes and audio will be sent. If a value is specified in 
the shortcut, it overrides the default value from the configuration page of the Connector. See 
Formats For Sending Notes and Audio. 
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• the Format in which the notes and audio should be sent. 

You can modify an existing shortcut by clicking its row in the table of the Shortcuts tab, selecting 
different values in the columns, and clicking Save.

Creating a Custom Shortcut for Computer

In this mini-tutorial, you will create a custom shortcut named Image that targets the 
C:\Users\Desktop\Planning folder on your computer and sends notes only (without audio) as a 
graphic image. 

1. Click Add Shortcut. 
2. Enter a name for the shortcut. In this example, enter: Image. 

3. Click the down-arrow in the Connector column and select the Computer Connector. 
The Folder link appears. 

4. Click Folder. 
5. Click Choose Folder, browse to an existing folder (or create a new one) on your computer file 

system, and click OK. 
In this example, click Choose Folder and create a new folder. For the folder’s name, enter: 
Planning. Then click OK (Windows) or Create (Mac). 

6. Click the down-arrow in the Format column. 

7. Select PNG Image from the menu. 

8. Click Save. 

Sending to Computer Using a Shortcut

You can send notes and audio to your computer, using default or custom shortcuts. In this mini-tutorial, 
you send content using the Image shortcut you just created. 

1. Draw a Launch Line and write the first few letters of the shortcut word directly above it.
For example, writing Com displays the Computer shortcut. In this case, write Im to display your 
Image shortcut. For more information, see Drawing a Launch Line. 

2. Wait until the smartpen displays: Tap each page to include, then double tap.
3. Select a page by tapping on it. Select another page in the same notebook by tapping on it. 

Continue tapping on pages in the same notebook to select them. 
Alternatively, you can select part of a page. For more information, see Selecting Part of a Notebook 
Page. 
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4. (optional) You can select a send format for your notes and audio that is different from the default 
value. The default format for a shortcut is specified on the Shortcuts tab of the Livescribe 
Connect computer app.

a. Using Tap Around and the shortcut word you wrote, tap right to select a different send 
format for your notes and audio. For more information, see Navigating Submenus with Tap 
Around. 

b. Tap down to display other send formats. Tap right to select a send format. 

5. Double-tap on the final page you wish to send. Connect (dock) your smartpen to your computer. 
If you used the Image shortcut, notes only are sent to the Planning subfolder of your Desktop 
folder on your computer. 

Sending to MyLivescribe

Using the MyLivescribe Connector, you can send notes and audio to your MyLivescribe space. The 
following mini-tutorials configure the MyLivescribe Connector, create a custom shortcut, and send 
content from your smartpen using the new shortcut. 

Configuring the MyLivescribe Connector

In this mini-tutorial, you configure the MyLivescribe Connector. 

By default, your uploaded notes and audio on your MyLivescribe space have the Private property: it can 
be seen only by you. If you wish more people to see your content, make it public by changing the privacy 
options in Livescribe Online. 

1. Click the MyLivescribe icon on the Connectors tab of the Livescribe Connect computer app. 

2. Under Login Information, enter your MyLivescribe account information in Email and Password. 
These are the email address and password that you use to log on to 
http://www.livescribe.com/community. It is the same account used by Livescribe Desktop—for 
example, when you click the Livescribe Online tab in Livescribe Desktop. 

3. Click the Test Connection button to make sure that the MyLivescribe Connector can connect to 
Livescribe Online. 
A green light on the button indicates that the connection is successful. 
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4. If you remember your MyLivescribe email address, but you have forgotten your password, click 
the Forgot Password button. 
An email describing how to reset your password is sent to your email address. 

a. Connect to your email account and find the email message from Customer Service 
Livescribe. 

b. Follow the instructions in the email to reset your password. If you ignore this email, your 
password remains unchanged. 

5. If you do not yet have a MyLivescribe account, click Create New Account. 
a. In the Create Account dialog, enter your email address in the Email text box, and enter your 

password twice: in the Password and Confirm Password text boxes. 
b. Select a country from the Language drop-down list. Then click the Create button. 

6. Enter a name in the Default Pencast Name text box. All notes and audio sent to your 
MyLivescribe space will have this name. 
If you leave this field blank, the name will default to the notebook name and page number. For 
Example: 1-Subject Notebook 8 p. 113 

Defining Shortcuts for MyLivescribe

The MyLivescribe Connector has default shortcuts. You can also create your own custom shortcuts. 

The MyLivescribe Connector has the following default shortcuts: 

• MyLivescribe 

• Mobile 

• iPhone 

• iPad 

Default and custom MyLivescribe shortcuts specify the following: 

• the MyLivescribe Connector. This cannot be changed in default shortcuts. 

• the Format in which the notes will be sent. This cannot be changed in any MyLivescribe shortcut. 
The format for sending content is .pencast, since MyLivescribe requires a Pencast file to provide 
an interactive version of the notes and audio over the web. See Formats For Sending Notes and 
Audio. 
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Creating a Custom Shortcut for MyLivescribe

You can create custom shortcuts for the MyLivescribe Connector, perhaps to provide shorter, 
easier-to-write names. In this mini-tutorial, you create a custom MyLivescribe shortcut with the 
name LS. 

1. Click the Add Shortcut button. 

2. Enter a name for the shortcut. In this example, enter: LS. 

3. Click the down-arrow in the Connector column and select the MyLivescribe Connector. 

4. Click Save. 

Sending to MyLivescribe Using Shortcuts

You can send notes and audio to your MyLivescribe page using default or custom shortcuts. In this 
mini-tutorial, you send content using the LS shortcut you just created. 

1. Draw a Launch Line and write the first few letters of the shortcut word directly above it.
For example, writing MyL displays the MyLivescribe shortcut. In this case, write L to display your 
LS shortcut. For more information, see Drawing a Launch Line. 

2. Wait until the smartpen displays: Tap each page to include, then double tap.
3. Select a page by tapping on it. Select another page in the same notebook by tapping on it. 

Continue tapping on pages in the same notebook to select them. 
IMPORTANT:  You cannot select part of a page when using the MyLivescribe Connector. You can 
select only a whole page. Livescribe Connect shortcuts that use the MyLivescribe Connector 
include: MyLivescribe, Mobile, iPad, and iPhone. 

4. When you are finished selecting pages, double-tap on the final page you wish to send. Connect 
(dock) your smartpen to your computer. 
If you used the LS shortcut, notes and audio are sent to your MyLivescribe space. 

Sending to Mobile

Using Mobile, you can send notes and audio to MyLivescribe, your personal page in Livescribe Online. 
No configuration should be necessary. The mini-tutorial sends notes and audio, using the default Mobile 
shortcut.

Notes and audio that you send to MyLivescribe are sent as Pencast files, which you can view in your 
web browser or on the Livescribe Mobile iPhone app.
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Configuring Mobile

The Mobile shortcut uses the MyLivescribe Connector. 

• If you configured the MyLivescribe Connector already, you need do nothing further. 

Sending Using Mobile

You can send notes and audio to MyLivescribe, using the Mobile shortcut. In this mini-tutorial, you send 
content using Mobile. 

1. Draw a Launch Line and write the first few letters of the shortcut word directly above it.
Write Mo to display your Mobile shortcut. For more information, see Drawing a Launch Line. 

2. Wait until the smartpen displays: Tap each page to include, then double tap.
3. Select a page by tapping on it. Select another page in the same notebook by tapping on it. 

Continue tapping on pages in the same notebook to select them. 
IMPORTANT:  You cannot select part of a page when using Mobile.

4. When you are finished selecting pages, double-tap on the final page you wish to send. Connect 
(dock) your smartpen to your computer. 
Notes and audio are sent to MyLivescribe. 

Sending to Evernote

Using the Evernote Connector, you can send notes and audio to your Evernote account. The following 
mini-tutorials configure the Evernote Connector, create a custom shortcut, and send content from your 
smartpen using the new shortcut.

Configuring the Evernote Connector

In this mini-tutorial, you configure the Evernote Connector. 

1. Click the Evernote icon on the Connectors tab of the Livescribe Connect computer app. 

2. Enter your Evernote account information in the User name and Password text boxes. 

3. Click the Test Connection button to make sure the Evernote Connector can connect to the 
Evernote server. A green light on the button indicates the connection is successful. 
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4. If you do not have an Evernote account or wish to upgrade your existing account, click the link or 
image to learn more. 
Your notes and audio are sent to the default notebook of your Evernote account. If you wish to 
specify a different notebook, create a custom shortcut for the Evernote Connector. 

Defining Shortcuts for Evernote

The Evernote Connector has a default shortcut that you can modify. You can also create your own 
custom shortcuts. 

The Evernote Connector has the following default shortcut: 

• Evernote 

Default and custom Evernote shortcuts specify the following: 

• the Evernote Connector. This cannot be changed in default shortcuts. 

• the Evernote Notebook to which notes and audio will be sent. If no value is specified, notes and 
audio will be sent to the default notebook specified in your Evernote account. 

• the Evernote Tag which will be applied to the notes and audio when they are sent to Evernote. 
You can specify multiple tags, separated by commas. 

• the Format in which notes and audio should be sent. See Formats For Sending Notes and Audio. 

You can modify an existing shortcut by clicking its row in the table of the Shortcuts tab, selecting 
different values in the columns, and clicking the Save button. 

Creating a Custom Shortcut for Evernote

In this mini-tutorial, you create a custom shortcut named Staff that targets the Staff Meetings notebook 
in your Evernote account and applies the Offsite tag, and sends a simple PDF only (without attached 
audio). 

1. Click Add Shortcut. 
2. Enter a name for the shortcut. In this example, enter: Staff. 

3. Click the down-arrow in the Connector column and select the Evernote Connector. 
The Notebook link appears. 
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4. Click Notebook and enter the name of the Evernote notebook to which content should be sent. 
In this example, enter Staff Meetings. 
If you do not specify a valid Evernote notebook in this text box, the Evernote Connector uses the 
default notebook you specified on the Evernote web site or Evernote desktop app. 

5. Click the Tags link and enter one or more Evernote tags that should be applied to your content 
when it reaches your Evernote notebook. 
In this example, enter: Offsite. 
If you enter nothing in this text box, the Evernote Connector applies no tags to the content. 
If you enter text that does not match existing tags in your Evernote account, the Evernote 
Connector creates new tags based on this text. 

6. Click the down-arrow in the Format column. 
The menu contains available formats for the Connector. 

7. Select the desired format from the menu. In this example, select PDF. 

8. Click Save. 

9. (optional) Log in to Evernote and create a notebook called Staff Meetings.

Sending to Evernote Using Shortcuts

You can send notes and audio to your Evernote account, using default or custom shortcuts. In this 
mini-tutorial, you send content using the Staff shortcut you just created.

1. Draw a Launch Line and write the first few letters of the shortcut word directly above it. 
For example, writing Ev displays the Evernote shortcut on the smartpen. In this example, write 
Sta to display your Staff shortcut. For more information, see Drawing a Launch Line. 

2. Wait until the smartpen displays: Tap each page to include, then double tap.
3. Select a page by tapping on it. Select another page in the same notebook by tapping on it. 

Continue tapping on pages in the same notebook to select them. 
Alternatively, you can select part of a page. For more information, see Selecting Part of a Notebook 
Page. 

4. (optional) You can select a send format for your notes and audio that is different from the default 
value. The default format for a shortcut is specified on the Shortcuts tab of the Livescribe 
Connect computer app.

a. Using Tap Around and the shortcut word you wrote, tap right to select the send format for 
your notes and audio. For more information, see Navigating Submenus with Tap Around. 

b. Tap down to display other available send formats. Tap right to select a send format. 
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5. Double-tap on the final page you wish to send. Connect (dock) your smartpen to your computer. 
A simple PDF is sent to the Staff Meetings notebook in your Evernote account. 
If you did not create a Staff Meetings notebook in your Evernote account, the Staff shortcut sent 
content to your default Evernote notebook. If that happened to you, you may wish to take a 
moment now to create a Staff Meetings notebook in your Evernote account, and then re-try the 
Staff shortcut with your Livescribe smartpen. 

Sending to Facebook

Using the Facebook Connector, you can send notes and audio as a Pencast to your Facebook wall. The 
following mini-tutorials configure the Facebook Connector, create a custom shortcut, and send content 
from your smartpen using the new shortcut. 

The uploaded Pencast is an interactive Flash movie that initially displays in your post as a thumbnail of 
the first page with a start button. When a viewer clicks on the start button, the Pencast plays in place. 
Information about the upload displays to the side of the thumbnail. 

Configuring the Facebook Connector

In this mini-tutorial, you configure the Facebook Connector. 

1. Click the Facebook icon on the Connectors tab of the Livescribe Connect computer app. 

2. Click the Sign Into Facebook button and enter your Facebook login information. 

3. Enter appropriate default values in the following text boxes. You can override these default values 
by creating custom shortcuts for the Facebook Connector. 

a. Wall Message: Message that appears directly beneath your name on the post. 
Corresponds to the “Say something about this video” text box in the Facebook video 
uploader. 

b. Wall Name: Title of your post that displays to the side of your uploaded Pencast. In bold 
type. 

c. Caption: Subtitle below the Wall Name. Summarizes the nature of the uploaded Pencast 
in a brief, eye-catching way. 

d. Description: A sentence or two describing the nature of the uploaded Pencast a little more. 



Sending to Facebook

Chapter 6:  Sending Notes and Audio with Your Smartpen 59

Defining Shortcuts for Facebook

The Facebook Connector has a default shortcut that you can modify. You can also create your own 
custom shortcuts. 

The Facebook Connector has the following default shortcut: 

• Facebook 

Default and custom Facebook shortcuts specify the following: 

• the Facebook Connector. This cannot be changed in default shortcuts. 

• Wall Message

• Wall Name

• Caption

• Description

• the Format in which notes and audio should be sent. This cannot be changed in any Facebook 
shortcut. The format for sending content is always Pencast PDF. It is a special version of Pencast 
that can be played from your Facebook wall. See Formats For Sending Notes and Audio. 

If the shortcut specifies a value for Wall Message, Wall Name, Caption, or Description, it overrides the 
corresponding default from the Connector's configuration page. 

All notes and audio sent with the same Facebook shortcut will have the same description values. To 
change the values, modify one or more of the fields in the shortcut definition, dock your smartpen, and 
then use the updated shortcut. 

You can modify an existing Facebook shortcut by clicking its row in the table on the Shortcuts tab, 
entering different values, selecting a different Format, and clicking Save. 

Creating a Custom Shortcut for Facebook

In this mini-tutorial, you create a custom shortcut named News. 

You provide values for the descriptive fields of the Facebook post as follows: 

• Wall Message:Just keeping the college community connected.

• Wall Name: Valley Community College

• Caption: Sounding Off

• Description: Heard on campus this week! Authentic audio from fellow 
students. Plus a wry written commentary.
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The format for sending pages is always Pencast. 

1. Click Add Shortcut. 
2. Enter a name for the shortcut. In this example, enter: News. 

3. Click the down-arrow in the Connector column and select the Facebook Connector. 
The Name text box appears, followed by Message, Caption, Description links. 

4. Enter a Wall Name. Then add text for Message, Caption, and Description as specified above. 

5. Click Save. 

Sending to Facebook Using Shortcuts

You can send notes and audio to your Facebook wall, using default or custom shortcuts. In this 
mini-tutorial, you send content using the Sound shortcut you just created. 

1. Draw a Launch Line and write the first few letters of the shortcut word directly above it.
For example, writing Fa displays the Facebook shortcut. In this case, write Ne to display your 
News shortcut. For more information, see Drawing a Launch Line. 

2. Wait until the smartpen displays: Tap each page to include, then double tap.
3. Select a page by tapping on it. Select another page in the same notebook by tapping on it. 

Continue tapping on pages in the same notebook to select them. 
Alternatively, you can select part of a page. For more information, see Selecting Part of a Notebook 
Page. 

4. When you are finished selecting pages, double-tap on the final page you wish to send. Connect 
(dock) your smartpen to your computer. 
When you dock your smartpen to your computer, a Pencast is posted to your Facebook Wall, with 
the following values:"Just keeping the college community connected," "Valley Community 
College," "Sounding Off," and Actually heard on campus...." 

Sending to Email Recipients

Using the Email Connector, you can send notes and notes as attachments to email. The following 
mini-tutorials configure the Email Connector, create a custom shortcut, and send content from your 
smartpen using the default shortcut and your new custom shortcut. 

An email can be sent to multiple recipients simultaneously. 
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NOTE:  Some files, particularly those with audio, are too large for many people's email systems. For 
information and alternatives, see Sending Large Files with Livescribe Connect. 

Configuring the Email Connector

In this mini-tutorial, you configure the Email Connector. 

Configuring the Email Connector consists of three steps: 

• Specify Outgoing Message Info that should appear on your email. 

• Provide the Email Setup Info for the outgoing email server. 

• Set up an Address Book that the Livescribe Connect smartpen app can use. 

1. Click the Email icon on the Connectors tab of the Livescribe Connect computer app. 

2. In the Outgoing Message Info section, do the following: 
a. In Your Name, enter the user-friendly name you wish to display in the From line of your 

emails. This setting is required. 
b. In Your Email Address, enter the email address from which you are sending emails. This 

setting is required. 
c. In Default Subject, enter a default subject that for Subject line of your emails. 

This setting is required; the default value is Note. You can override this value when you 
create a custom shortcut. 

d. In Always BCC emails to, enter an email address to which the Email Connector should 
send a copy of all your emails. For example, you might wish to send copies to yourself at 
another email address. Your recipients do not see the BCC line. This is optional. 

e. In the Signature, enter text you wish to display at the end of your email, as a closing. This 
setting is optional. 

3. In the Email Setup Info section, provide the setup information for the outgoing email server. 
The following table indicates the information required for common mail servers: 
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For Microsoft Exchange Server and other SMTP servers, please ask your domain administrator 
for details. 

4. Click Test Connection to make sure that the Email Connector can connect to the email server. 
A green light on the button indicates that the connection is successful. 

5. Click the triangle next to Address Book to expand the section in which you can add and modify 
contacts. 

a. In Name, enter the user-friendly name of the contact. 
b. In Email Address, enter the email address of the contact. 
c. Click the Add button. The new name and email address disappear from the text boxes and 

appear in a list directly below. 

6. If you wish to correct or remove entries in the list: Click the check box in front of the contacts, and 
then click Delete. 

Mail Server Required Information Example 

aol, gmail, 
hotmail 

Email Address 
Password 

johndoe@gmail.com 
shribleTy471 

Email Desktop 
Client 

No additional information required. If you 
have set up a default email program on 
your computer, Email Connector will use it. 

This is the email program that starts up when 
you click a mailto: link (such as Contact Us) 
on a web page. Not all users have a default 
email program. 

Microsoft 
Exchange 
Server 

Username 
Password 
Outgoing Mail Server (SMTP) 
Port 
Use a secure connection (SSL) 

johndoe 
re73bQnT 
mail.mycompanydomain.com 
587 
Check the box for yes 

Other (SMTP) Email Address 
Password 
Outgoing Mail Server (SMTP) 
Port 
Use a secure connection (SSL) 

johndoe@xyzcompany.com 
iu8e30o 
mail.xyzcompany.com 
ask your administrator 
ask your administrator 
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7. If you wish to retrieve contacts from an external, non-Livescribe address book, click the Import 
Contacts button. 

a. In the Import Contacts dialog, browse to a text file containing a list of contacts in CSV 
(comma-separated-value) format. Many address books can output a CSV list of contacts. 
NOTE:  You can import a maximum of 200 email addresses from an external address book.

8. Dock your smartpen to transfer your email address book to your smartpen. On the smartpen, you 
will select contacts from the Address Book when you are using the default Email shortcut. 

Defining Shortcuts for Email

The Email Connector has a default shortcut that you can modify. You can also create your own custom 
shortcuts. 

The Email Connector has the following default shortcut: 

• Email 

Default and custom Email shortcuts specify the following: 

• the Email Connector. This cannot be changed in the default shortcut. 

• the To, CC, and BCC lists of email recipients that make a custom shortcut into a kind of mail list. 
These fields are not available for the default Email shortcut. 

• the Subject line. If a value is specified in the shortcut, it overrides the Default Subject from the 
configuration page of the Email Connector. This field is not available for the default Email 
shortcut. 

• the Format in which notes and audio will be sent. See Formats For Sending Notes and Audio. 

The default Email shortcut does not permit you to define a mail list of To, CC, and BCC email recipients. 
Instead, the default Email shortcut assumes that you will select email recipients on the smartpen, using 
the Address Book defined in Email Connector's configuration page. 

You can modify an existing custom shortcut by clicking its row in the table on the Shortcuts tab, 
entering different values in the To, CC, BCC, and Subject fields, changing the Format selection, and 
clicking Save. You can modify the default Email shortcut as well, but you can change only Format. 

Creating a Custom Shortcut for Email

In this mini-tutorial, you create a custom Email shortcut named Team that targets three people who are 
“on your team” at work or a recreational activity and sends an image of your notes in PNG format. 

1. Click Add Shortcut. 
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2. Enter a name for the shortcut. In this example, enter: Team. 

3. Click the down-arrow in the Connector column and select the Email Connector. 
The To text box appears, followed by Add CC and Add BCC links. 

4. Enter email addresses in the To text box, separating them with commas. 
In this example, enter the email address of three people you know. If you wish, you can enter 
them now, and remove them by redefining the Team shortcut later. 

5. (optional) Click the CC link and enter the email address of anyone who is not a main recipient, 
but should receive a copy of the email. 

6. (optional) Click the BCC link and enter the email address of someone who should receive a copy 
of the email, but not appear in the To list of recipients. 

7. (optional) Click the Subject link and enter a subject. All emails sent with this shortcut will have 
this subject. 
If you specify no subject here, the default value from the Connectors tab of the Livescribe 
Connect computer app is used. 
The To text box is required. The other text boxes are optional. 

8. Click the down-arrow in the Format column. 
The menu contains available formats for the Connector. 

9. Select the desired format from the menu. 
In this example, select PNG Image. 

10. Click Save. 

NOTE:  You can create a maximum of 100 custom Email shortcuts.

Sending to Email Recipients Using the Default Email Shortcut

You can send notes and audio to Email recipients, using default or custom shortcuts. In this mini-tutorial, 
you send content using the default Email shortcut. After you select notebook page(s) to send, the 
smartpen display prompts you for email addresses, which you select from your Address Book. 

1. Draw a Launch Line and write the first few letters of the shortcut word directly above it.
Write Em to display the Email shortcut. For more information, see Drawing a Launch Line. 

2. Wait until the smartpen displays: Tap each page to include, then double tap.
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3. Select a page by tapping on it. Select another page in the same notebook by tapping on it. 
Continue tapping on pages in the same notebook to select them. 
Alternatively, you can select part of a page. For more information, see Selecting Part of a Notebook 
Page. 

4. When you are finished selecting pages, double-tap on the final page you wish to send. 

5. When the smartpen display shows To, tap down to see a list of email addresses from which you 
can select. 
This list comes from the Address Book that you defined when you configured the Email 
Connector. 

NOTE:  You can scroll to an email address by writing the first few letters of the user-friendly name 
in an unwritten area of a notebook page. For example, if you want to scroll to John Doe 
(jdoe@xyzcompany.com), write Jo. 

6. Tap right to select the current recipient. Each selected email recipient has a check mark before 
the name. 
NOTE:  If you want to skip to the end, double-tap on an unwritten area of a notebook page. 

7. If you want to select email addresses for CC and BCC or to select a format, continue as follows: 
a. Tap right to see show CC on the smartpen display. 
b. Tap down to select email recipients for CC one at a time. Tap right to select the current 

recipient. 
Each selected email recipient has a check mark before the name. 

c. When done selecting recipients for CC, tap right to show BCC on the smartpen display. 
d. Tap down to see email recipients for BCC one at a time. Tap right to select the current 

recipient. 
Each selected email recipient has a check mark before the name. 

e. When done selecting recipients for BCC, tap right to show Send As on the smartpen 
display.

f. Do one of the following: 

Tap right to accept the default send format for your notes and audio. That default 
format for a shortcut is specified on the Shortcuts tab of the Livescribe Connect 
computer app. 
Tap down to display other available send formats. Tap right to select a format. 

8. Connect (dock) your smartpen to your computer. 

NOTE:  In To, CC, and BCC, you can remove the check mark from an email recipient as follows: Tap up 
or tap down to show the name on the smartpen display, and then tap right. A message displays, 



Sending to Google Docs

66 Livescribe Connect User Guide

confirming that the recipient has been deselected. You can continue selecting and deselecting other 
recipients for the email message you are creating. 

Sending to Email Recipients Using a Custom Email Shortcut

You can send notes and audio to Email recipients, using default or custom shortcuts. In this mini-tutorial, 
you send content using the Team shortcut you created. A custom shortcut already has the list of email 
recipients defined, so the smartpen does not ask you to select from the Address Book. 

1. Draw a Launch Line and write the first few letters of the shortcut word directly above it.
For example, write Te to display your Team shortcut. For more information, see Drawing a Launch 
Line. 

2. Wait until the smartpen displays: Tap each page to include, then double tap.
3. Select a page by tapping on it. Select another page in the same notebook by tapping on it. 

Continue tapping on pages in the same notebook to select them. 
Alternatively, you can select part of a page. For more information, see Selecting Part of a Notebook 
Page. 

4. When you are finished selecting pages, double-tap on the final page you wish to send. 
When you dock your smartpen with your computer, an email with a PNG image of your notes is 
sent to the people specified on your Team shortcut. 

Sending to Google Docs

Using the Google Docs Connector, you can send notes and audio to your Google Docs. The following 
mini-tutorials configure the Google Docs Connector, create a custom shortcut, and send content from 
your smartpen using the new shortcut.

Configuring the Google Docs Connector

In this mini-tutorial, you configure the Google Docs Connector. 

Livescribe Connect can send notes and audio to a Google Docs account. To use this feature, provide 
your account information. 

1. Click the Google Docs icon on the Connectors tab of the Livescribe Connect computer app. 

2. Enter your Google Docs account information in Email and Password. 
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3. Click Test Connection to confirm the settings. 

4. In Default Collection Name, enter the default Google Docs collection to which you wish your 
pages sent. If you leave the text box blank, it will go to your default Collection. If you specify the 
name of a folder that does not exist, Livescribe Connect asks Google Docs to create it for you. 

5. In Share with, enter the default set of email addresses belonging to people you wish to have 
access to access your content in Google Docs. If you leave the text box blank, only you are able 
to access the content you send to Google Docs. 

Defining Shortcuts for Google Docs

The Google Docs Connector has a default shortcut that you can modify. You can also create your own 
custom shortcuts. 

The Google Docs Connector has the following default shortcut: 

• Google Docs 

Default and custom Google Docs shortcuts specify the following: 

• the Google Docs Connector. This cannot be changed in the default shortcut. 

• the Collection to which your notes and audio will be sent. If a value is specified in the shortcut, 
it overrides the default value from the configuration page of the Google Docs Connector. 

• the Share With field, which lists the email addresses of people who you wish to access your notes 
and audio in your Google Docs account. If a value is specified in the shortcut, it overrides the 
default value from the configuration page of the Google Docs Connector. 

• the Format in which notes and audio will be sent. See Formats For Sending Notes and Audio. 

You can modify existing shortcuts by clicking its row in the table on the Shortcuts tab, entering different 
values, selecting a different Format, and clicking Save. 

Creating a Custom Shortcut for Google Docs

In this mini-tutorial, you create a custom shortcut named Specs for the Google Docs Connector that 
targets the Design Specifications collection in your Google Docs account and sends a simple PDF 
(without attached audio) only. 

1. Click Add Shortcut. 
2. Enter a name for the shortcut. In this example, enter: Specs. 
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3. Click the down-arrow in the Connector column and select the Evernote Connector. 
The Add Collection and ShareWith links appear. 

4. Click the Add Collection link and enter the name of a Google Docs collection to which content 
should be sent. Enter Design Specifications.

5. Click the Share With link and enter one or more email addresses of people you wish to have 
access to your content. 

6. Click the down-arrow in the Format column. 
The menu contains available formats for the Connector. 

7. Select the desired format from the menu. 
In this example, select PDF. 

8. Click Save. 

9. For the sake of the mini-tutorial, create a Design Specifications Collection in your Google Docs 
account. You may skip this step, if you wish. Your smartpen content will be sent to your default 
collection. 

Sending Content to Google Docs Using Shortcuts

You can send notes and audio to your Google Docs account, using default or custom shortcuts. In this 
mini-tutorial, you send content using the Specs shortcut you just created. 

You can send notes and audio to Google Docs, using default or custom shortcuts. 

1. Draw a Launch Line and write the first few letters of the shortcut word directly above it.
For example, writing Go displays the Google shortcut. In this case, write Spe to display your 
Specs shortcut. For more information, see Drawing a Launch Line. 

2. Wait until the smartpen displays: Tap each page to include, then double tap.
3. Select a page by tapping on it. Select another page in the same notebook by tapping on it. 

Continue tapping on pages in the same notebook to select them. 
Alternatively, you can select part of a page. For more information, see Selecting Part of a Notebook 
Page. 
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4. (optional) You can select a send format for your notes and audio that is different from the default 
value. The default format for a shortcut is specified on the Shortcuts tab of the Livescribe 
Connect computer app.

a. Using Tap Around and the shortcut word you wrote, tap right to select the send format for 
your notes and audio. For more information, see Navigating Submenus with Tap Around. 

b. Tap down to display other available send formats. Tap right to select a send format. 

5. Double-tap on the final page you wish to send. 
A simple PDF is sent to the Design Specifications collection in your Google Docs. 

If you did not create a Design Specifications collection in your Google Docs account, then the 
Specs shortcut causes Google Docs to create a Design Specifications collection for you. 



Sending to Google Docs

70 Livescribe Connect User Guide



 

71

7  Formats for Sending

You can send notes and audio in various file formats. With the smartpen, you can specify format in the 
shortcut definition or at the time you select your content. With Livescribe Desktop, you specify the format 
at the time you select content. 

In addition to well-known formats, Livescribe uses two proprietary formats that allow notes and audio to 
be played in synchronization: 

• Pencast is the format used by Livescribe Desktop and Livescribe Online. 

• Pencast PDF is a new format that Livescribe is introducing with Livescribe Connect. When 
opened in Adobe Reader X or above, a Pencast PDF can play the audio and display notes in 
synchronization. 

Formats For Sending Notes and Audio

Notes and audio can be sent in various formats. Some formats support both notes and audio whereas 
others support notes only or audio only. 

.pencast (or Pencast) Proprietary format used only in Livescribe Desktop and MyLivescribe 
(Livescribe Online). Notes that display in synch with the recorded audio. 

Pencast PDF A PDF format playable in Adobe Reader X or above. Notes that display in 
synch with the recorded audio. See Viewing and Playing a Pencast PDF

PDF Standard PDF format viewable in Adobe Reader X or above. Notes, with no 
audio. 

PNG Image The PNG format. An image of your notes, with no audio. 

M4A Audio The M4A format (AAC). Audio associated with your notes, with no notes. M4A 
files can be imported into common audio players like iTunes.
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Connectors and Their Formats

Not all formats are available for each Connector. The table below lists each Connector and the formats 
in which it can send your notes and audio. It also describes how the file is displayed at the destination 
and any tips on how to interact with the file. 

Connector 

Sending 
Formats 
Supported At Destination 

Computer Pencast 
PDF 

A file on your computer. 

PDF A file on your computer. 

.pencast A file on your computer. 

PNG Image A file on your computer. 

M4A Audio A file on your computer. 

MyLivescribe Pencast In your MyLivescribe space, the first page of each uploaded pencast 
appears in a vertical list. In the center of your MyLivescribe space, the 
currently selected Pencast displays in a frame with playback controls. 

Evernote Pencast 
PDF 

As an attachment to a note. In the Evernote web app, click the attachment 
icon. In the Evernote computer app, hover over the note window and click 
the small Adobe Reader icon. Adobe Reader X starts. You can view all 
pages in the Pencast PDF and use the Pencast PDF control bar to play the 
recorded audio. 

PDF  As an attachment to a note. In the Evernote web app, click the attachment 
icon. In the Evernote computer app, hover over the note window and click 
the small Adobe Reader icon. Adobe Reader X starts. You can view all 
pages in the PDF. 

PNG Image Image displays in the note window. 

Facebook Pencast The post displays a thumbnail of the first page with a triangular start 
button. A viewer clicks the start button to play the Pencast in place. 
Descriptive info displays to the right of the post. 
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Overriding Formats on the Smartpen

Send formats are generally specified in a shortcut definition. However, you can override the specified 
format from your smartpen at the time you select notes and audio.

For more information, see Selecting Format from the Smartpen.

Viewing and Playing a Pencast PDF

Pencast PDF is a new format of notes and audio that can play in Adobe Reader X or above. 

Google Docs Pencast 
PDF 

 A file in the specified Collection of your Google Docs account. To play the 
Pencast PDF, download the file to your computer and double-click it. 
Adobe Reader X will launch and you can view the notes and play the 
audio. 

NOTE:  If you view the file online in Google Docs, you will see the notes but 
will not be able to play the audio. 

PDF A file in the specified Collection of your Google Docs account. You can 
view the PDF online in Google Docs or download it to your computer. 

Email Pencast 
PDF 

 A file is attached to the email. 

PDF  A file is attached to the email. 

.pencast  A file is attached to the email. 

PNG Image Each notebook page becomes an image file. All files are attached to the 
email. 

M4A Audio Each audio recording is a separate audio file. All files are attached to the 
email. 

Connector 

Sending 
Formats 
Supported At Destination 
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With earlier versions of the Livescribe Platform, you can send your notes and audio as Pencast files and 
your recipients can use them in Livescribe Desktop, which is available as a free download. In Livescribe 
Desktop, users can read your notes, play your audio, and make custom notebooks. 

Now you can also send your notes and audio in a universal format—Pencast PDFs. In Adobe Reader 
X, your recipients can read your notes and play your audio. 

NOTE:  Pencast PDFs sent to your computer using the Computer Connector are updated automatically 
with new ink and audio that you add to your notebooks. This is similar to how Livescribe Desktop 
updates your notebooks when you dock your smartpen. 

You can open a Pencast PDF as you would other PDF files in Adobe Reader X. The main difference is 
that a Pencast PDF can contain ink that has associated audio—called "active ink". Click active ink to 
play its audio. This is just like playing a Pencast from Livescribe Online or in Livescribe Desktop. 

When you first view a notebook page, active ink appears in green type. When you click active ink, it 
turns gray and the audio starts playing. As audio playback continues, the gray ink turns green in 
synchronization with the audio. Non-active ink (ink without audio) is black and does not change 
appearance. 

Audio Control Bar

Pencast PDFs have an audio control bar for playing, pausing, and stopping audio playback. The control 
bar also has jump controls, bookmarks (stars), and an audio timeline control. 

Active Ink View Button

There is also an active ink view button . Click this button to toggle the "unwritten" color of active ink from 

gray to invisible. In the default (gray) setting, the gray words turn green as the audio plays. In the 
invisible setting, green words seem to write themselves on blank paper as the audio plays. 
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Sharing a Pencast PDF Without Connectors

Like other PDF files, you can share a Pencast PDF with just about anyone. Once you send the Pencast 
PDF to your computer, you can share the entire file (page and audio) without using Connectors. For 
instance, you can copy it to a network drive, post it to your blog, or copy it to a flash drive. Anyone with 
Adobe Reader X or higher can view and play the audio with the audio control bar. 
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Sharing Audio Only

1. In Adobe Reader X, click the Attachments button . This opens the Attachments panel. 

2. In the Attachments panel, select the audio file(s) and click the Save button to save them to your 
desktop or other folder. Once they are saved separately, you can share the audio without 
Connectors. You can copy it to a network drive, post it to your blog, or copy it to a flash drive. 
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8  Getting More Info About the 
Livescribe Connect Smartpen App

You can get more information about the Livescribe Connect smartpen app, including the version 
number and the address for the customer support web page. 

Getting Livescribe Connect Version Information

1. Launch the Livescribe Connect smartpen app, using the Connect shortcut or Nav Plus. 

2. Tap down until you see About on the smartpen display. 

3. Tap right. 
The current version of the Livescribe Connect smartpen app shows on the display. 

Getting the Web Help Information

1. Launch the Livescribe Connect smartpen app, using the Connect shortcut or Nav Plus. 

2. Tap down until you see About on the smartpen display. 

3. Tap right. 
The current version shows on the smartpen display. 

4. Tap down until you see Help. 

5. Tap right to see the web address for the Livescribe support web page. 
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9  Sending Notes and Audio from 
Livescribe Desktop

Using Livescribe Desktop and the Livescribe Connect computer app, you can send smartpen notes and 
audio to many popular destinations. 

Configuring Connectors in Livescribe Desktop

Connectors are plugins to Livescribe Connect that target a particular destination: a folder on your 
computer, one of your Evernote notebooks, your MyLivescribe space, your Facebook wall, email 
recipients, or one of your Google Docs collections. 

In the Livescribe Connect computer app, you configure Connectors. In Livescribe Desktop, you send 
notes and audio from your electronic notebooks, and then provide other input required by a Connector. 

Although a Connector must be configured before use, the same configuration works for the smartpen 
and Livescribe Desktop. If you configured Connectors for use on the smartpen, you need not configure 
them again for Livescribe Desktop. 

Accessing Connector Configuration from Livescribe Desktop

You can access the configuration page for a Connector from Livescribe Desktop. 

• In Livescribe Desktop, click a Connector icon in the Connectors pane of the Library tab. 
The Livescribe Connect computer app displays, with the configuration page for the Connector 
showing. 

Selecting and Sending in Livescribe Desktop

When sending notes and audio from Livescribe Desktop, select notebook pages and drag them to a 
Connector icon. 
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Make format and other selections in dialogs, and then send the notes, audio, or both. In Livescribe 
Desktop, you do not use smartpen shortcuts. 

IMPORTANT:  All selections must be from the same notebook. 

NOTE:  When using the Email Connector, keep in mind that some files, particularly those with audio, are 
too large for many people's email systems. For information and alternatives, see Sending Large Files 
with Livescribe Connect. 

Sending Notes and Audio from the Thumbnail View

You can select content from the Thumbnail View of the Pages View. 

1. Click the Pages View. 

2. Make sure that Thumbnail View is active. If you see a single, full-size page, you are currently in 
Single-Page View. Click the Thumbnail View icon  on the control bar: 

3. Select one or more pages you want to send. 

4. Drag the pages to one of the Connectors in the left navigation pane. 
The Sending Notes to... dialog displays for you to select notes and audio from your pages. 
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5. Under Select what to send, specify whether to send the notes, audio, or both from your pages. 

Pages With Audio Send notes and the audio linked to them.

Pages Only Send just the notes.

Audio Only Send just the audio.
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6. Under Select your file type, select the file format in which to send your notes or audio. 
Available file formats depend on the Connector you are using and whether you are sending notes, 
audio, or both. See Formats For Sending Notes and Audio. 

7. (optional) Click the More Options button. 
The Select your content section of the dialog drops down. 

8. Select individual pages or audio. 
• Select one or more of the pages you dragged to the Connector icon. If a page has a check 

mark, its notes will be sent. 
• Select one or more audio recordings from the pages you dragged to the Connector icon. If 

an audio recording has a check mark, it will be sent. 

NOTE:  The pages pane or the audio recordings pane may be grayed out and unusable, depending 
on whether you decided to send notes, audio, or both in the Select your content box above. 

The Select All /Deselect All check box at the top of a pane toggles between selecting all and 
selecting none of the items in the pane. 

9. If you wish to preview an audio recording before sending it, select the audio and click the play 
button on the Audio Controls. Drag the slider of the Audio timeline control to reposition audio 
playback forwards and backwards. Click the Pause control to stop playback. 

10. Click Continue. 
Livescribe Connect sends your notes and audio to the destination. If the Connector requires 
further information, an options dialog displays. 

11. In the options dialog, provide further information relevant to the Connector you are using. Then 
click Send. 

Right-Clicking in the Thumbnail View

As an alternative to dragging pages, you can right-click on pages in Livescribe Desktop to send them 
using Connectors. 

1. In the Thumbnail View, select one or more pages from the same notebook, and then right-click. 

2. Choose Send Page X to..., where X is the page number in the notebook. 
If you selected more than one page, the menu item says Send Y Pages, where Y is the number 
of notebook pages. 

3. Choose a Connector. 
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4. Continue as you would if you had dragged the pages to an icon in the Connectors pane. Make 
selections in the Sending Notes to... dialog and the options dialog (if the Connector you chose 
has an options dialog). 

For details, see Sending Notes and Audio from the Thumbnail View. 

Sending Notes and Audio from the Audio View

You can select notes and audio from the Audio View. 

1. Click the Audio View. 

2. Select one or more audio recordings. Use Control + click to select multiple audio recordings. 

3. Right click and select Send 'X' to, where X is the date and time of the recording you are sending. 
If you are sending more than one recording, the menu item says Send Y Selected Sessions, 
where Y is the number of recordings you are sending. 

4. Select a Connector from the submenu. 
The rest of the steps are the same as on the Pages View. 

In the Sending Notes To dialog, the More Options section has thumbnails of the pages with 
notes linked to the audio. You can select one or more of those pages to send with the audio 
recordings. Alternatively, you could deselect all pages to send just the audio recordings. If the 
audio recordings are a paperless session, you will see no pages in the pages 

Specifying Send Options

Some Connectors send notes and audio when you click Continue. Others display a further dialog 
where you specify additional information. These Connectors are: 

Connector Send Option 

Computer The File Save As dialog displays. You can accept the default name for your 
file or give it a different name. 
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Exporting and Importing Pencast Files With Livescribe Desktop

The Pencast file format (.pencast) lets you and others exchange and send your smartpen content, 
including audio, pages, or both. 

Anyone with Livescribe Desktop installed on their computer can import Pencast files. Because Pencast 
files are a native Livescribe format, you can work with imported Pencast files just like other pages and 
audio, including viewing and searching pages, playing back audio, and even sending. 

Exporting to Pencast Files

You can export Pencasts from Livescribe Desktop. You might want to back up Pencast files or an entire 
notebook on an external device (such as a portable hard drive or USB flash key) or your network server. 

Sending an Entire Notebook from Livescribe Desktop

In Livescribe Desktop, send an entire notebook to your computer, external device, or network. 

1. Right click on a notebook in the Library tab of Livescribe Desktop. 

2. Select Send Notebook...

Facebook If you are not logged in to Facebook, the Facebook Login dialog displays. Enter 
your login information. 
The Facebook Wall Post Options dialog also displays. You can specify Wall 
Message, Wall Name, Caption, and Description. Info you specify here 
overrides defaults you set during Facebook Connector configuration. Click 
Post when you are done. 

Email The Email Send Options dialog displays. You must enter at least one email 
address in the To text box. You may also add email addresses for CC and 
BCC and enter a Subject. The BCC and Subject you enter in this dialog 
override defaults you set during Email Connector configuration. Click Send 
when you are done. 

Connector Send Option 
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3. Select a Connector. 
TIP:  The Computer and Google Docs Connectors are the best choice for large files. The Email 
Connector may not be appropriate, since many mail servers limit attachments to a maximum of 
10 MB. 

4. Make selections in the Sending Notes to Computer dialog. You can accept the default format 
(which is Pencast) or select a different format. When you are done, click Continue.

5. In the Save File As dialog, navigate to a file system location on your computer, external device, 
or network. Enter a name for the file that will contain your notes and audio. Then click Save. 
Notes and audio are sent in a file to the location you selected, and the file has the name you 
specified. 

Importing Pencast Files

Pencast files that you receive from other people must be imported into Livescribe Desktop before you 
can use them. 

You may also wish to access Pencast files that you created as backups, which can be useful if you lose 
your computer or smartpen. To use such Pencast files, download Livescribe Desktop from the 
Livescribe web site and import them into your new Livescribe Desktop. 

You may also wish to access Pencast files that other people have saved to a shared location, such as 
a network server at work. You can import these files into your Livescribe Desktop as well. 

1. Select File > Import Pencast. 
2. In the dialog, navigate to the appropriate folder and select the Pencast you wish to import. 

3. Click Import. 
Livescribe Desktop puts the file under Imports in the Library tab. 
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